Contents

Release Notes for RobotStudio 2020.3 3
General 3
  User documentation 3
  Tutorials 3
  System Requirements 3
What's new in RobotStudio 2020.3 6
  IRB 1300 Foundry 6
  IRB 14050 bottom connector 6
  IRB 390 6
  Quick setup of position signals for recording 7
  RAPID Editor - Dark color theme 7
  Recording Playback 7
  Support for all revisions of a RobotWare release 8
  Trace TCP Category 1 stop position 8
  Unicode in RAPID strings and comments 8
Corrections 9
Known Limitations 14
  Visual SafeMove 14
  IO Engineering Tool 14
  IO Configurator 6 15
  Online 15
  Online – Paint 15
  Online – Integrated Vision 15
  Offline 17
  Conveyor Tracking 21
  MultiMove 21
  External Axis 21
  Network Drives and UNC Paths 22
  RAPID 22
  Paint 23
Graphics and Geometry 23
RobotWare Compatibility 25
  Supported RobotWare versions 25
  RobotWare 5.05 and 5.06 Compatibility 25
  RobotWare 5.07 Compatibility 25
  RobotWare 5.08 Compatibility 25
  RobotWare 5.10 Compatibility 25
  RobotWare 5.11 Compatibility 25
  RobotWare 5.12 Compatibility 26
  RobotWare 5.13 Compatibility 26
  RobotWare 5.15 Compatibility 26
  RobotWare 6 Compatibility 27
General Compatibility Limitations 27
Release Notes for RobotStudio 2020.3

General

The release name is RobotStudio 2020.3 and the build number is 20.3.9251.0. The release date is December 4, 2020.

User documentation

The RobotStudio Operating Manual is available in all languages except Czech, i.e. English, German, French, Korean, Chinese, Japanese, Spanish. A selected set of RobotWare manuals are available. Each of them is available in two versions, one for IRC5 and one for OmniCore.

Tutorials


System Requirements

Required Software

Microsoft Windows 10 Anniversary Edition or later, 64-bit edition, is required.

The Windows AppInstaller is a pre-requisite for the virtual OmniCore FlexPendant software, see https://www.microsoft.com/en-us/p/app-installer/9nblggh4nns1. The App Installer is a default built-in app in Windows 10, but may have been removed on some PCs.

Sideloading of apps must be enabled on Windows 10 to install the virtual OmniCore FlexPendant, see below:
## Recommended Hardware

<table>
<thead>
<tr>
<th>ITEM</th>
<th>REQUIREMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>2.0 GHz or faster processor, multiple cores recommended</td>
</tr>
<tr>
<td>Memory</td>
<td>8 GB minimum</td>
</tr>
<tr>
<td></td>
<td>16 GB or more if working with large CAD models</td>
</tr>
<tr>
<td>Disk</td>
<td>10+ GB free space, solid state drive (SSD)</td>
</tr>
<tr>
<td>Graphics Card¹</td>
<td>High-performance, DirectX 11 compatible, gaming graphics card from any of the leading vendors. For the Advanced lightning mode Direct3D feature level 10_1 or higher is required.</td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>1920 x 1080 pixels or higher is recommended</td>
</tr>
<tr>
<td>Mouse</td>
<td>Three-button mouse</td>
</tr>
<tr>
<td>3D Mouse</td>
<td>Any 3D mouse from 3Dconnexion, see <a href="http://www.3dconnexion.com">http://www.3dconnexion.com</a>.</td>
</tr>
</tbody>
</table>
1 RobotStudio will not benefit from the additional features of so-called 'Professional' or 'Workstation' graphics cards. The price level of these are at a much higher range than gaming graphics cards with comparable performance. High-end gaming PCs are very suitable for offline programming with RobotStudio. Such a PC will provide good performance for a limited budget.
What's new in RobotStudio 2020.3

- IRB 1300 Foundry
- IRB 14050 bottom connector
- IRB 390
- Quick setup of position signals for recording
- RAPID Editor - Dark color theme
- Recording Playback
- Support for all revisions of a RobotWare release
- Trace TCP Category 1 stop position
- Unicode in RAPID strings and comments

**IRB 1300 Foundry**
The Foundry version of IRB 1300 has been added to ABB Library. It is supported in RobotWare 7.1.

**IRB 14050 bottom connector**
A variant of the IRB 14050 with bottom connector has been added to ABB Library.

**IRB 390**
The IRB 390 10 kg and 15 kg have been added to ABB Library. They are supported in RobotWare 6.11.
Quick setup of position signals for recording

Added a new Signal Setup option to include all robot position signals in a Signal Analyzer recording. These recordings can be viewed using the new Recording Playback functionality.

RAPID Editor - Dark color theme

Added a button in Options to apply a dark color theme to the RAPID text editor with a single click.

Recording Playback

Use the new Playback feature to view robot movements from a Signal Analyzer recording. The recording should contain joint signals for all mechanical units in the station.
Navigate to a specific time to see how the robot was positioned at that time or play back the whole recording. If the Signal Analyzer window is open, the selected time is indicated by a vertical line in the window.

Support for all revisions of a RobotWare release
Removed the revision number (e.g. 6.11.02) from the information about supported RobotWare versions in Help/About. RobotStudio supports all revisions of a given RobotWare release.

Trace TCP Category 1 stop position
In trace TCP, it's now possible to select either category 0 or category 1 stop position visualization.

Unicode in RAPID strings and comments
Starting with RobotWare 7.1 it is possible to use Unicode characters in RAPID strings which makes it possible to create applications that interacts with users in any language. You can also use Unicode characters in your comments.

- The file extensions for RAPID module files have changed from .mod and .sys to .modx and .sysx. This is to distinguish these files from the files created with earlier RobotWare versions that do not support Unicode. RobotWare 7.1 can load .mod and .sys files but will always save as .modx and .sysx.
- RobotStudio supports Unicode characters in all scenarios where RAPID modules are created, modified, saved, loaded and so on.
- When creating a new module file from the File tab, options for .modx and .sysx has been added.

Example:

```
MODULE MySysModule(SYSMODULE)
  ! Grinning Face
  VAR string face := "😊 Grinning Face";
ENDMODULE
```
<table>
<thead>
<tr>
<th>PDD</th>
<th>Correction</th>
</tr>
</thead>
<tbody>
<tr>
<td>11118</td>
<td><strong>Discrepancy between RobotStudio and online CAD data for IRB-1200</strong>&lt;br&gt;The IRB 1200 models have been updated to match the real robot with regards to the dowel holes in the base.</td>
</tr>
<tr>
<td>11287</td>
<td><strong>Message Box after using change options function not correct</strong>&lt;br&gt;If an I-start is required after performing &quot;Change Options&quot; on a virtual controller the standard I-start dialog is now displayed, in order to inform the user that all configuration parameters and RAPID programs will be discarded.</td>
</tr>
<tr>
<td>11512</td>
<td><strong>Group I/O in Smart Component changed from signed to unsigned integer</strong>&lt;br&gt;The value type of Group I/O signals in Smart Components has been changed from signed to unsigned. Such signals can now represent a full 32 bit value range and be connected to a group signal in a Virtual Controller without issue.</td>
</tr>
<tr>
<td>12090</td>
<td><strong>FMB library missing in equipment folder</strong>&lt;br&gt;An entry for &quot;Floor Mounting Base&quot; was visible in the &quot;Equipment&quot; library even though the model is not available. The entry has been removed.</td>
</tr>
<tr>
<td>12094</td>
<td><strong>Confusing messages when saving station</strong>&lt;br&gt;When saving a station in a solution, the &quot;Station was saved&quot; message could appear before all backups had completed. This has been fixed.</td>
</tr>
<tr>
<td>12198</td>
<td><strong>Unexpected behavior of the Reset simulation button with physics</strong>&lt;br&gt;Fixed an issue with the internal physics model not being updated properly after performing Reset Simulation or Undo.</td>
</tr>
<tr>
<td>12365</td>
<td><strong>Error in video recording</strong>&lt;br&gt;Fixed an issue with video recording when the RobotStudio window was on a secondary monitor in a multi monitor environment.</td>
</tr>
<tr>
<td>12419</td>
<td><strong>CPU Load signal removed from the list of monitored signals in Signal Analyzer</strong>&lt;br&gt;Starting from RobotStudio 2019.2, monitoring of CPU Load signal has been made unavailable in the Signal Analyzer, but this change was not documented. RobotStudio Operating Manual has now been updated to reflect this change.</td>
</tr>
<tr>
<td>12435</td>
<td><strong>Not possible to delete multiple RAPID modules</strong>&lt;br&gt;When multiple RAPID modules where deleted simultaneously an exception was logged to the output window, and only one RAPID module was deleted. This has now been fixed.</td>
</tr>
<tr>
<td>Issue ID</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| 12479    | **Move Along Path does not work**  
Fixed an issue where 'Move Along Path' was not working and giving the error message "Command failed, check the controller status." |
| 12505    | **Text editor saves unicode characters in XML files incorrectly**  
The text editor has been updated, fixing a problem that made unicode characters saved in an incorrect way for XML files. |
| 12585    | **Gearbox Heat Prediction suggests unavailable cooling kit for IRB6700**  
Fixed an issue where the Gearbox Heat Prediction tool could suggest a cooling kit for IRB6700 axis 2 that is not available for purchase from after sales. |
| 12617    | **Visual SafeMove - Unable to set CIP Safety, NodeID and SSN**  
Safe IO Configurator has been updated making it possible to modify CIP Safety IP address and Safety Network Number, saving it to file or writing it to the controller. |
| 12711    | **Wrong limits on axis 1 on robot 6620LX**  
RobotStudio has been updated, fixing a bug that made axis 1 on robot 6620LX having wrong limits. |
| 12717    | **String resources in virtual Operator Window**  
RAPID string resources used in for example a TPWrite instruction would sometimes not be displayed correctly in the virtual Operator Window; the resource identifier would be displayed instead. This has been fixed. |
| 12770    | **Exception in Motion Configuration with external axis**  
Fixed a crash in Motion Configuration for a virtual controller with external axes. |
| 12795    | **Physics problem for parts attached to robot.**  
Parts attached to a physics enabled robot are now automatically set to Kinematic. It is also possible to change the physics behavior of attached parts between Kinematic and None. |
| 12825    | **Bottom value of a Safe Zone can be higher than top value in Visual SafeMove**  
Safe Zone has been updated, showing an error when the bottom value exceeds the top value. |
<table>
<thead>
<tr>
<th>Issue Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>12876</td>
<td><strong>RAPID editor tooltip color</strong></td>
</tr>
<tr>
<td></td>
<td>Fixed the text colors in the RAPID Quick-info tooltip to comply with the colors set in Options.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="RAPID editor tooltip color example" /></td>
</tr>
<tr>
<td>12881</td>
<td><strong>Safe IO Configurator is not showing CI502 signals, only Global signals</strong></td>
</tr>
<tr>
<td></td>
<td>Safe IO Configurator is now showing CI502 signals.</td>
</tr>
<tr>
<td>12964</td>
<td><strong>Invalid characters in Japanese version of RobotStudio Operating Manual</strong></td>
</tr>
<tr>
<td>12997</td>
<td><strong>RobotWare release check is not always correct</strong></td>
</tr>
<tr>
<td></td>
<td>See Support for all revisions of a RobotWare release.</td>
</tr>
<tr>
<td>13024</td>
<td><strong>Problem with unpacking RobotStudio P&amp;G file</strong></td>
</tr>
<tr>
<td></td>
<td>Pack &amp; Go files with a virtual controller using RobotWare 7.0 to 7.0.4 could not be unpacked because a license file in the backup had expired. This has been fixed by using the license file from RobotWare 7.0.5 instead.</td>
</tr>
<tr>
<td>13030</td>
<td><strong>Fatal error in VrSession</strong></td>
</tr>
<tr>
<td></td>
<td>Fixed a crash in the VrSession Smart Component.</td>
</tr>
<tr>
<td></td>
<td><strong>Translate Path with MoveAbsJ failure</strong></td>
</tr>
<tr>
<td></td>
<td>Fixed an issue in Translate Path that would fail or produce incorrect result for MoveAbsJ instructions.</td>
</tr>
<tr>
<td></td>
<td><strong>Insert Action Instruction: Create button is not disabled when required parameters are missing</strong></td>
</tr>
<tr>
<td></td>
<td>In 'Insert Action Instruction', the 'Create' button was enabled even if required parameters were not specified. This has been fixed.</td>
</tr>
<tr>
<td></td>
<td><strong>Library Manager: Filtering of libraries or geometry with extension is not working</strong></td>
</tr>
<tr>
<td></td>
<td>The Search function in Library Manager did not support filtering on the file extension. This has been fixed, and support for wildcards (*) has been added.</td>
</tr>
<tr>
<td>Issue</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>An exception occurs when user tries to deactivate himself in 7.x controller</td>
<td>In ‘Edit User Accounts’ for a 7.x controller, the logged in user could clear the activated state of his own account which would lead to an error when trying to apply the changes. This has been fixed.</td>
</tr>
<tr>
<td>Error when exporting CAD geometry of an empty part</td>
<td>Removed the possibility to export an empty part (with no bodies) to a CAD format.</td>
</tr>
<tr>
<td>Invisible bodies become visible after load</td>
<td>Geometric bodies that were hidden in the graphics would sometimes become visible after saving and loading the station. This has been fixed.</td>
</tr>
<tr>
<td>Color is not retained after defeature</td>
<td>The Defeature function would not retain the colors of the modified part or body. This has been fixed.</td>
</tr>
<tr>
<td>An error occurs when user clicks on RAPID Path Editor for an encoded module</td>
<td>Removed an error message that would occur when trying to launch the RAPID Path Editor for an encoded module.</td>
</tr>
<tr>
<td>Visual SafeMove -Checksum difference if writing an old safety configuration with a newer RobotStudio</td>
<td>Writing a configuration generated with Robot studio 6.04.01 or older will cause the checksum to change. When the user try to do this, a message box is now shown that informs the user about this change.</td>
</tr>
<tr>
<td>Exception when closing Online Monitor</td>
<td>Fixed an exception that occurred when the Online Monitor windows was closed in float mode.</td>
</tr>
<tr>
<td>Signal Analyzer recordings not included in Pack &amp; Go</td>
<td>After the redesign of Signal Analyzer, the recordings are saved as separate files which were not included in Pack &amp; Go files. This has been fixed.</td>
</tr>
<tr>
<td>Exception on clicking Print in Visual SafeMove</td>
<td>Visual SafeMove has been updated making it possible to print even if the system name happens to be empty.</td>
</tr>
<tr>
<td>Unable to configure SafeMove for stand alone controller</td>
<td>Fixed an issue that prevented creating a Safe Range or Global Supervision for a stand alone controller.</td>
</tr>
<tr>
<td><strong>Visual SafeMove - Tool Speed Supervision from recording throws exception</strong></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td></td>
</tr>
<tr>
<td>Before the Tool Speed Supervision button was enabled even if the points didn't form a valid polygon. Now the button is disabled in this case. Before the first tool was selected if there were more than one tool. Now you have to select a tool if there is more than one tool. Disable reason is added for all buttons in the Auto Generate from Simulation category (Safe Zone, Safe Range, Tool Orientation Supervision, Tool Only, Tool and elbow).</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Visual SafeMove - A system without a robot cannot open a safety configuration that has a robot specified</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed an issue where an exception would be thrown when trying to open a safety configuration file that had a robot specified, while the robot system is a Stand Alone controller.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Visual SafeMove - Exceptions thrown when report saved/written</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>If robot controller is used, online monitor has to be opened to generate geometries. Before an error occurred while generating the PDF report. Now the report is generated without geometries.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>SmartComponent - Even though part is made as &quot;Not detectable by sensor&quot;, it is getting detected</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>The Smart Component &quot;ClosestObject&quot; could detect objects with &quot;Detectable by Sensors&quot; disabled. This has been fixed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Restore of backup repeated 3 times</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>When restoring a backup the restore command was incorrectly sent 3 times to the controller. This could cause a restore command being sent to the controller after an hour from the initial restore. This issue has now been fixed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Visual SafeMove - Axis 7 joint values not read for YuMi</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>When clicking &quot;Read Current Values&quot; in the Visual SafeMove synchronization properties window for a YuMi or Single-arm YuMi, axis 7 got the same joint value as axis 1. The correct value is now read for axis 7.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Collision Avoidance - Incorrect visualization for Single-arm YuMi</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Corrected an issue where the visualization of Single-arm YuMi and attached objects differed between Online Monitor and Collision Avoidance configuration window.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>IRB 360-1/1130 Stainless/No axis 4 missing from ABB Library</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>The IRB 360-1/1130 Stainless/No axis 4 model has been added to ABB Library.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Visual SafeMove - Single Arm YuMi axis 7 Sync position displayed in millimeters</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed an issue where the Sync position for the Single Arm YuMi was displayed in millimeters, instead of degrees in the safety report.</td>
</tr>
</tbody>
</table>
Known Limitations

Visual SafeMove

Current joint values cannot be retrieved when external axes are included in the configuration

It is not possible to retrieve the current joint values using the Read current values function on the Synchronization node when external axes are included in the configuration. Workaround: Read the values from the FlexPendant and update manually.

The safety controller is not forwards compatible

When writing a safety configuration file of a later version than the current safety controller image, then RobotStudio will generate an error of type “C00FFFE: Unknown error (0xC004FFFE)LoadSafetyConfigurationFile”. (Note that this error may occur for other reasons as well and is thus not unique to this case).

The function Get vectors from active tool reads values from the robot

The idea behind this function is to to read the data from the currently active tool of the robot in order to define a corresponding SafeMove Tool in the safety configuration. That is the reason why the tool information is read from the robot and not the safety controller. The tools of the safety configuration are visible the Visual SafeMove itself and does not need a special function to be retrieved.

Protected checksum may change when upgrading RW from 6.04.0x to 6.05 or 6.06

The protected checksum will change if the input and output modules of the internal device is protected. The reason is that two attributes change order.

No visualization of Safe Range for external axes in Visual SafeMove for SafeMove Basic or Pro

When Safe Range is used to limit the axis range of an external axis such as a track motion, there will be no visual indication of the actual range in the graphic view.

Visual SafeMove windows can be re-opened from the Quick Access Toolbar menu

Any windows that are closed can be re-opened using the Quick Access Toolbar menu, as the command Default Layout does not recover these windows.

SafeMove Tool Zone visualization in Online Monitor for robots with external axes

Only TCP robots and track mounted robots will be visualized in the Online Monitor, no other external axes or positioners. As a consequence, the Online Monitor may show the robot in a non-violating position, even though the safety controller has detected a safety violation and stopped the robot.

IO Engineering Tool

Breaking change of PROFINET parameters between RobotWare 7.0.x and RobotWare 7.1

A major change to configuration parameters of PROFINET has been introduced. Backwards compatibility with earlier configurations has been broken.

For systems with PROFINET this means:

- It will not be possible to use RobotStudio 2020.3 and forward with RobotWare 7.0.x, instead RobotStudio 2019.5.5 can be used.
- It will not be possible to load configuration files containing PROFINET for RobotWare >= 7.1 created for RobotWare 7.0.x.
**IO Configurator 6**

*Safety configuration problem with PROFIsafe Controller or CIP-Safety scanner*

Changing safety settings in Visual SafeMove or IO Configurator 6 does not always work in conjunction with the "PROFIsafe controller" or "CIP-Safety Scanner" option. Connection with robot controller can be lost during any IO-configuration, sometimes resulting in that the Flex Pendant reboots. Again this is only applicable when the PROFIsafe controller or CIP-Safety scanner option is present in the system. Problem is dependent on how many devices are configured on respective industrial network. I.e. EtherNet/IP or Profinet.

**Online**

*Individual RAPID tasks cannot be stopped for RobotWare 5.60 and later*

When running multitasking systems, it is not possible to start and stop individual tasks with the dropdown menu of the task node in the Controller browser. This is due a restriction introduced with RobotWare 5.60 and later.

*Individual RAPID tasks cannot be stopped for RobotWare 5.60 and later*

When running multitasking systems, it is not possible to start and stop individual tasks with the dropdown menu of the task node in the Controller browser. This is due a restriction introduced with RobotWare 5.60 and later. However, from RobotWare 6.03 onwards, then RAPID tasks to execute or to stop can be selected from RobotStudio RAPID tab.

*FlexPendant Viewer running with automatic reloading*

When having FlexPendant Viewer running with automatic reloading of the screens and at the same time jogging the robot with the joystick the robot jogging might halt when the FlexPendant Viewer reloads.

**Online – Paint**

*Backup for Paint systems does not create backup of the PIB for IRC5P with RobotWare 5.xx*

The Backup function of RobotStudio does not create a backup of the PIB board of the IRC5P system when running RobotWare 5.xx. Workaround: Create the backup of the PIB board with the FlexPaint Pendant using an USB-stick.

*Go Offline does not work for Paint systems*

The Go offline function will not create a working Virtual controller system for Paint system unless the Paint package I/O option is set to Simulated.

**Online – Integrated Vision**

*Installation error when having previous versions of RobotStudio or Insight Explorer*

If you have a previous version of RobotStudio or Cognex In-Sight software installed, installing a new version of RobotStudio may result in the following error message

```
Module C:\Program Files (x86)\Common Files\Cognex\InSight\5.7.1674.0\CvslnSightDisplay.ocx failed to register. HRESULT -2147220472. Contact your support personnel.
```

*Workaround:* To correct the issue, open Windows Settings -> Apps -> Apps & features, select the current ABB RobotStudio 2019.x, select Modify, and step through the installation wizard and select Repair. Alternatively, uninstall and reinstall RobotStudio.

*Note:* Only one version of the In-Sight Display Control can be registered at a time, and this is always the
latest version installed. Although older versions of RobotStudio or In-Sight may seem to function with this version installed, their compatibility with this version is not guaranteed.

RobotStudio may hang for up to 60 seconds when configuring jobs with PatMax 1-50

The user interface of RobotStudio may freeze for up to 60 seconds when configuration Integrated Vision jobs with the tool PatMax 1-50.

**Workaround:** Use PatMax 1-10 instead

Remaining error – New Emulators

New camera models have been added to the camera emulator option in RobotStudio 6.04.01. Some of these new models are not yet fully compatible. Our recommendation is to choose a camera model from the 7000 series which is fully compatible with Firmware version 4.10.2.

Emulated cameras not discovered when controller in Motors On

For RobotWare 5.61 onwards, the camera discovery mechanism is disabled when the controller is in Motors On. As a consequence, the camera nodes will not appear in the controller browser.

**Workaround:** Switch to Manual Reduced Speed and use the Refresh command on the Integrated Vision node in the browser to make the cameras appear.

Information – Camera firmware version and update

The minimum firmware version to be used with Integrated Vision is 4.08. If this version is not available for a specific camera model, then the newest version available shall be used. There are two important things to know before upgrading a sensor:

- The user must make sure to first backup the files on the camera. This can be done using the Rapid snippets for camera backup/restore, or the FlexPendant Explorer.
- The latest available firmware version may vary across sensor types. However, when the firmware update utility presents the latest available version it shows the firmware with the highest version number which may not apply to the sensor to be updated. However, the appropriate firmware will be applied.

Information – The spreadsheet view

The spreadsheet view is not enabled when editing in the in the following modes “Add part location tool”, “Add part inspection tool”. Before entering the spreadsheet mode click for example “Setup Image” or Output to Rapid.

Information – Calibration board without fiducial

When using the calibration boards, checkerboard or board with dots, the user must select the preferred origin by clicking and accepting (press enter) three points on the board. Only after these three points have been selected it is possible to click ”calibrate” to execute the calibration.

Information - Use default camera settings

If the camera is not using default communication settings the result may be that RAPID instructions return error code “Communication Error”. The safest method to get default settings is to go to Connect->Add Sensor Right click and select “Show all sensors”. Select the device to reset and click “Apply factory settings” in the lower right corner. The most important settings are:
Information – User Credentials

It is now possible to create user profiles with different access levels on the camera. For detailed information about this, please refer to the Integrated Vision User Manual.

Remaining error – Save image on camera

It is not possible to save an image on the camera using “Save Image”. This is by design, but the dialog still allows the user to try to do this. The result is that the image is not saved and no error message is given.

Remaining error - Connect button greyed out for no reason

It may sometimes happen that the “Connect” button is greyed out, with the tooltip saying the camera is not on the correct subnet although the IP settings are OK.

Workaround: Restart the Integrated Vision Add-In

Remaining error – VC started from Controller->Add controller does not detect cameras

A VC that is started from Controller->Add controller does not detect cameras on the network, even if the VC_network_definition.xml is correctly configured and the firewall is turned off. The reason is that the controller is not able to detect new cameras on the network when it is in “Motors On” state. When the VC is started stand-alone in RobotStudio it is automatically set to “Motors On” when started.

Workaround: To allow it to discover cameras, turn the control panel key to manual mode or launch the VC as part of a station.

User tip - Removing cameras from configuration

To remove a configured camera from the list of configured cameras, use the configuration editor. Enter Configuration->Communication->Application Protocols and remove the desired camera. Perform a warm start to complete the operation.

User tip – Viewing all cameras present on the network

Connect->Add Sensor is normally used for setting the IP addresses of sensors that are not currently on the correct subnet (192.168.125.X). Since the dialog shows all cameras “seen” by the PC, this dialog is useful when error tracing camera network problems. If a camera does not appear on the network using the “Add sensor” dialog as suggested above, it is advisable to cycle the power of the camera. If the camera receives power from the controller, then cycle power by turning the mains switch.

User tip – Warm start the controller after changing network settings

Whenever changing the network settings of the camera, either from Connect->Add Sensor or Connect->Network settings, it is important to warm start the controller. If this is not done, RAPID instructions will give the error “Communication Error” and the FTP-mounted camera disk is not accessible. If DHCP address is used and persist, please try a static address instead.

Offline

*Issue with collision avoidance for palletizer robots

When configuring collision avoidance for a palletizer robot using RobotWare 6.11, attaching an object to a mechanism link can result in an error and the configuration will not be loaded.
*The YuMi library revision 1 cannot be successfully updated to YuMi revision 2*

When opening a Pack&Go file with a station that has a reference to IRB14000_0.5_0.5__01.rslib you get the option to update it to the newer IRB14000_0.5_0.5__02.rslib.

The following issues occur if you select ‘Yes’ and update the model:

- The attached parts, for example Smart Grippers, are detached.
- The new YuMi robot is not connected to the virtual Controller.
- The old YuMi mecanism is converted to a component.

Answer ‘No’ to this question to keep the original revision 1 model and avoid the problems mentioned above.

**RobotStudio needs to be restarted to update a modified library instance**

When editing a library file (.rslib) that is used in a currently open station, then RobotStudio needs to be restarted to update the library. Simply re-opening the station is not enough to update the content of the station. Unless RobotStudio is restarted, the old library instance will remain in memory and be loaded even though the underlying file has been updated. This is a known limitation and is expensive to fix.

There is a workaround to the problem, which is to restart RobotStudio.

**The robot IRB 1600ID 1.55 m / 6kg replaced by IRB 1660ID 1.55 m / 6 kg in RobotWare 6.04**

The robot IRB 1600ID 1.55 m / 6 kg is not available in RobotWare 6.04 and later. It has been renamed to IRB 1660ID 1.55 m / 6 kg. Virtual controller systems for IRB 1600ID 1.55 m / 6 kg based on RobotWare 6.03 cannot be upgraded to RobotWare 6.04 and later. This means that Pack&Go files for this robot based on RobotWare 6.03 cannot be upgraded to RobotWare 6.04 automatically.

**Workaround:** Re-build or modify the virtual controller system to use IRB 1660ID 1.55 m / 6 kg instead when using RobotWare 6.04 or later.

**FlexPendant and RAPID applications run with logged in user rights**

**A FlexPendant or RAPID application running on the virtual controller runs with the rights of**

the logged-in Windows user. RAPID applications running in a background task will start to execute when the Pack&Go file is opened and FlexPendant applications will start to execute when the user starts the Virtual FlexPendant. A warning message has been added to the Unpack&Work wizard to make the user aware that only Pack&Go files (.rspag) from trusted sources shall be opened.
Compatibility of RobotStudio Library and Stations with older RobotStudio versions

RobotStudio is generally not forwards compatible, i.e. it is not possible to load stations or libraries created in RobotStudio 6.04 into an earlier version of RobotStudio such as e.g. RobotStudio 5.x, 6.03.02 or earlier. However, RobotStudio is backwards compatible, which means stations and libraries created in versions 5.x, 6.03.02 or earlier can be opened in RobotStudio 6.04.

TrueMove path visualization fails for customized zone data

The TrueMove path visualization function only supports predefined zonedata. It will not work for user defined zonedata.

Backup fails for RobotStudio solutions with SafeMove or Electronic Position Switches

Backups are automatically created for virtual controller systems that are part of a RobotStudio solution when saving the station. For virtual controller systems with the RobotWare options SafeMove or Electronic Positioning Switches the backup will fail since these systems contain files that are read-only. As a result, an error message is presented in the output window: <System name>: Backup failed. The station will be successfully saved but there will be no backup created. Workaround: Ignore the error message <System name>: Backup failed and create a manual backup whenever needed. The RobotStudio Option “Enable automatic backup of controllers in solution” that is available in "RobotStudio Options -> Robotics -> Virtual Controller” can be de-selected to disable the backup function.

IRB 14000 cannot be combined with any other robot

The function system from layout fails if trying to create a MultiMove system where one robot is an IRB 14000. The reason is that the IRB 14000 cannot be combined with any other robot.

Workaround: Create a separate system for the IRB 14000.

The Work Envelope function does not support IRB 14000

The function is disabled for the IRB 14000 and cannot be activated.

The 2D work envelope fails for certain robot models
As a result, the generated work envelop may appear distorted.

**Update of current selection in the 3D graphics window may be delayed**

A problem related to the graphics driver has been observed on certain PCs. The problem is that the update of the current selection in the 3D graphics is delayed until the next redraw.

**Workaround:** Add or uncomment the following line in the file RobotStudio.exe.config

```
<add key="DoublePresentWorkaround" value="true" />
```

**Failure to open Pack&Go file to same folder the second time**

RobotStudio will prevent Pack&Go files to be opened to the same folder a second time if the station contains VC systems with the EPS or SafeMove option. This is by design to prevent the safety controller configuration file to be accidentally overwritten.

**Workaround:** Remove the write protection manually using Windows Explorer.

**Updates of instruction template and code snippets**

RobotStudio will not automatically update the user files for instruction templates and code snippets files in the folders:

- `...\My Documents\RobotStudio\Instruction Templates`
- `...\My Documents\RobotStudio\Code snippets`

**Workaround:** The user has to manually copy the latest files from

`%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Instruction Templates`

and

`%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Code Snippets`

to the data folder.

**I/O signals configured with access level 'DEFAULT'**

When I/O signals are configured with access level 'DEFAULT', only input signals are possible to set/reset from the I/O Simulator and I/O Window. To be able to affect also output signals, set the access level to ‘ALL’ for them in the Configuration Editor.

**VC does not start with RRI option and GSI folder structure missing**

The VC will hang when started with a system containing the RobotWare option RRI (Robot Reference Interface) if the GSI folder structure is missing.

**Workaround:** Create GSI Folder before starting the VC inside the `HOME` directory of the system. See the Application Manual for Robot Reference interface for more information.

**System in Guard Stop state in Automatic mode after run-time error**

Certain run-time errors may cause the controller system to enter Guard Stop state in Automatic mode. This is the same behavior as in a physical robot controller system. This typically happens when a run-time error related to Conveyor Tracking occurs. A simulation cannot be started when the controller is in this state.

**Workaround:** To reset the controller state, open the Control Panel window and first switch to Manual
mode, and then back to Automatic mode.

**Path handling of instructions with multiple joint targets**

The path functions Rotate, Translate, and Mirror do not work as expected with instructions containing via points as jointtargets. The functions will leave the jointtargets as is. Interpolate Path gives an Unknown Error and Tool Compensation reports an error message.

**Event Manager: Simulation cannot be triggered by analog system signals**

The event manager only supports analog station signals, not analog system signals.

**Conveyor Tracking**

*Conveyor objects must be re-added for stations created prior to RS 6.05*

When opening stations with conveyor tracking created prior to RobotStudio 6.05, conveyor objects must be re-added.

**Incorrect default values for c1Position and c1Speed for RobotWare 5 with the PaintWare option**

The default values for the parameters c1Position and c1Speed may become incorrect for a virtual controller system. The symptom is that its attribute values are all zero, see snapshot below.

**Workaround:** Save the following lines to a CFG file named ‘TEMP.CFG’ or similar and load in the virtual controller followed by a restart.

```plaintext
EIO:CFG_1.0:5:0::
#
EIO_SIGNAL:
-Name "c1Position" -SignalType "AI" -Unit "CnvIf"
-TextLabel "ctPosition" -UnitMap "0-31" -Access "ALL"
-MaxLog 21474.8 -MaxPhys 1 -MaxPhysLimit 1
-MaxBitVal 2147483647 -MinLog 21474.8 -MinPhys -1 -MinPhysLimit -1
-MinBitVal 2147483647
-Name "c1Speed" -SignalType "AI" -Unit "CnvIf" -TextLabel "ctSpeed"
-UnitMap "32-63" -Access "ALL"
-MaxLog 21474.8 -MaxPhys 1 -MaxPhysLimit 1
-MaxBitVal 2147483647 -MinLog 21474.8 -MinPhys -1 -MinPhysLimit -1
-MinBitVal 2147483647
```

**MultiMove**

**MultiMove error: ‘Object reference not set to an instance of an object’**

When the Test Play button is pressed in the MultiMove tool, the following error message may be displayed: ‘Object reference not set to an instance of an object’, but the robot moves and the Status ‘Calculation OK’ is displayed. In addition, when ‘Create Paths’ is pressed the following message is displayed: ‘Can't create paths : Value cannot be null’, and no paths are created. In the ‘Create Paths Settings’, is the WP TCP drop down empty.

**Reason:** Workobject is not set for the current task.

**External Axis**

**Error 50091: ‘Restart not possible’ after warm start of a system with external axis**

When restarting a system with activated mechanical units the activation state is lost. Then the program can no longer be started from the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window.

**Workaround:** Reset the program pointer (‘Program Pointer to Main’) before starting the program from
the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window, or, start the program from the Simulation Play button.

Network Drives and UNC Paths

RobotStudio on computers with roaming user profiles

RobotStudio may fail on PC configurations with roaming user profiles, i.e. when the users' documents folder resides on a server and not on the local disk.

Workaround: Redefine the 'User Project Folder' to a folder on the local disk (File → Options → General → Files&Folders → User Project Folder).

Virtual Controller does not support UNC paths

UNC paths cannot be used to locate Virtual Controller systems. Using UNC paths for VC systems will cause the log message ‘Failed to initialize FW upgrade framework’ to appear when the system starts. Subsequent attempts to work with the VC such as synchronizing RAPID data will fail.

Creating and starting systems located on a network drive

When using a network drive to store RobotStudio data such as RobotWare systems or the RobotWare mediapool, the following problems may occur:

- Virtual controller does not start
- Not possible to open Virtual FlexPendant

Cause: By default, the .NET Framework does not allow execution of code from a remote file system. This means the application may behave unexpectedly if the media used by the system or the system itself resides on a network share.

Workaround: To resolve this, the user must explicitly grant the required permissions:

1. Open the file Virtual FlexPendant.exe.config located in C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 5.61\Bin
2. Add the following lines:

   ```xml
   <?xml version="1.0"?>
   <configuration>
     <startup useLegacyV2RuntimeActivationPolicy="true">
       <supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0"/>
     </startup>
     <runtime>
       <loadFromRemoteSources enabled="true"/>
     </runtime>
   </configuration>
   ```

The Virtual FlexPendant must be restarted for the changes to take effect. For further information, see http://msdn.microsoft.com/en-us/library/dd409252(v=vs.100).aspx

RAPID

Robtargets that are LOCAL to a PROCEDURE cannot be synchronized with RobotStudio

The RobotStudio synchronization engine that translates 3D data of the station to RAPID code and vice versa does not support robtargets that are declared locally to a procedure.

Workaround: Declare the robtargets as global or local to a module instead.
Robtarget names must be unique in RAPID even if they are LOCAL

RobotStudio requires that robtarget names are unique for the RAPID synchronization to work properly, i.e. you cannot have a global robtarget named pMyTarget1 in module A and a local robtarget with the same name in Module B.

Global robtargets cannot be made local through Synchronization to VC

Global robtargets cannot be changed to local through Synchronization to VC, the option is disabled (PDD 3140).

Workaround: Change the robtargets to module local in the RAPID Editor and Synchronize to station.

Error Message: Sync. to Station completed with errors

Error Message: Sync to Station completed with errors: New data name type has same name as existing object in same block routine.

When this error message appears, there is a storage type mix-up between data already stored in RS and in the VC. Because of this, and per design, the data is not considered the same data.

Workaround:

1. Ensure all data declarations have the same definition in RS as in RAPID (there is no user interface for this).
2. Sync to station should now work.
3. Sync back to controller, and remember to change the data declarations back to what you want.

Paint

The new conveyor tracking module DSQC2000 is not supported for paint robots.

The new conveyor tracking module DSQC2000 is not supported for paint robots.

Lack of Virtual Controller support for the Paint systems

Paint systems that are configured using the Paint package I/O option Discrete, Compact or Fieldbus, will result in a SysFail state.

Workaround: Re-create the system with the simulated I/O option.

Graphics and Geometry

*Display of working range optimized for furthest reach

The current algorithm uses a fixed value for joint five which gives the furthest reach for a given tool. The sweep is not optimized to get the shortest reach on the “inside” of the working area.
Enforce selected graphics device for PCs with multiple graphics cards

For best performance when running RobotStudio on a PC with multiple graphics cards, RobotStudio can be configured to use a specified device. By this option you can ensure maximum performance. This is useful for e.g. Lenovo W540 that has both an integrated Intel graphics device and a discrete NVIDIA card.

Open the file `RobotStudio.exe.config` that is located in the folders

`C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio x.y\Bin64`

and

`C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio x.y\Bin`

and uncomment the line:

```xml
<add key="GraphicsDeviceType" value="Discrete"/>
```

Valid values are 'Discrete', 'Integrated' and 'Warp' (software renderer). Note that there are two different files, one for the 32-bit version, and another for the 64-bit version.

Problems when undoing Boolean operations on Geometry

Undoing a Boolean operation might not succeed. To recover from these problems, you need to delete the items that caused the problem.
RobotWare Compatibility

Supported RobotWare versions

RobotStudio works with RobotWare 5.07 and later. Please check details below. The latest supported RobotWare version for IRC5 and OmniCore controllers is stated under Help/About in RobotStudio. RobotWare packages can be added to RobotStudio from the RobotApps window.

RobotWare 5.05 and 5.06 Compatibility

RobotWare 5.05 and 5.06 including revisions thereof are not supported by RobotStudio 5.15 and later versions. Please use the corresponding version of RobotStudio for managing robot controllers with any of these RobotWare versions.

RobotWare 5.07 Compatibility

General

The location of the program pointer is not updated in the RAPID Editor during program execution.

Offline

A limitation in the versions 5.07.02, 5.07.03, and 5.07.04 of RobotWare may cause the Virtual Controller to System Failure state during I-start on certain computers. The problem is due to the ctrl.bin-file not being correctly created.

Workaround: Create an empty ctrl.bin file in the INTERNAL folder of the controller system, and then perform a warm start.

Note: The problem will reappear if the system is I-started. The virtual controller does not support RobotWare 5.07.08 and RobotWare 5.07.07.

Online

FlexPendant Viewer does not work RobotWare 5.07.

RobotWare 5.08 Compatibility

RobotWare 5.08 and its revisions are supported with the following limitations:

Offline

RobotWare 5.08 is not supported.

Workaround: Use RobotWare 5.08.01 or later.

RobotWare 5.10 Compatibility

RobotWare 5.10 and its revisions are supported with the following limitations:

Offline

Starting a controller will generate internal UAS error in controller error log.

RobotWare 5.11 Compatibility

RobotWare 5.11 and its revisions are supported with the following limitations:

Offline

Linear jogging of a robot across joint values that will cause a change of confdata may fail. For example, if the robot is jogged linearly when joint values is passing 90 degrees for axis 1 may cause the robot to stop or to change configuration.
RobotWare 5.12 Compatibility

RobotWare 5.12 and its revisions are supported with the following limitations:

Paint

Paint backups from RW 5.12.01 are not compatible with RW 5.12.02 or later. Restoring a paint system backup from RobotWare 5.12.01 will cause SysFail for RobotWare 5.12.02 or later.

Workaround: Add the following parameters to the configuration files:

EIO.CFG

```
EIO_SIGNAL:
   -Name "doMainInMC" -SignalType "DO" -Unit "SysComm" -UnitMap "44"
   -Name "A1HVErrNo" -SignalType "GO" -Unit "SysComm" -UnitMap "150-151"
   -Access "ALL"
   -Name "A1HVEn" -SignalType "DO" -Unit "SysComm" -UnitMap "155"
   -Access "ALL"

EIO_CROSS:
   -Res "A1HVEn" -Act1 "HVEnabled"
```

SYS.CFG:

```
CAB_TASK_MODULES:
   -File "INTERNAL:/pntrapid/T_ROB1/cycinfo.sys" -ModName "cycinfo"
   -Task "T_ROB1"
   -File "INTERNAL:/pntrapid/csvlkup.sys" -ModName "csvlkup" -AllTask
   -Hidden
```

RobotWare 5.13 Compatibility

RobotWare 5.13 and its revisions are supported with the following limitations:

Paint

Paint backups from RW 5.12.02, 5.12.03 or RW 5.13 or 5.13.01 not compatible with RW 5.13.02 or RW 5.13.03. There are several changes in the configuration database for I/O (EIO.CFG) and Controller (SYS.CFG) that will cause System Failure if an old backup is loaded. There are also changed in installed RAPID modules. To create a compatible configuration, proceed as follows:

1. Create and start a VC with a RobotWare 5.13.03 system containing the same options as your original backup, but do not load the backup.
2. Save the EIO.CFG and SYS.CFG to file.
3. Compare the saved files with the corresponding files of your backup. (You can use a text file comparison tool for simplification.)
4. Add your system-specific configuration to the general configuration files saved from the 5.13.01-system using a text editor.
5. Replace the files of the original backup with the corresponding modified configuration files.
6. Go through the RAPID modules of the backup and remove the default modules (i.e. those that are not changed by the user).
7. Load the backup and restart the system. You are done.

RobotWare 5.15 Compatibility

Signal Analyzer Online

The feature Signal Analyzer Online requires RobotWare 5.15.03 or later.
RobotWare 6 Compatibility

Overview

RobotWare 6.00 and 6.00.01 systems cannot be directly upgraded to RobotWare 6.01. To upgrade a system, you need to create backup and migrate it using the tool ‘Migrate Backup or Folder’, then recreate the system and finally, restore the backup. For this reason, the functions ‘Unpack&Work’, ‘Go Offline’ and ‘New Solution with Station and Robot Controller – From backup’ are blocked to prevent upgrade from RobotWare 6.00 or 6.00.01 to RobotWare 6.01. RobotStudio, however, is compatible with both RobotWare 6.00 / 6.00.01 and 6.01.

General Compatibility Limitations

Safety Configuration

Safety configuration of a track motion IRC5 system equipped with a safety controller of type EPS or SafeMove can be done without the need to read track motion parameters manually when using RobotWare 5.11.01 or later. Encrypted parameters needed by the safety controller will be automatically read by EPS Wizard and SafeMove Configurator, respectively.

Configurations

The feature Configurations for selecting the robot arm configuration (confdata) may fail, or not present all solutions, in some specific circumstances even when the target is reachable if RobotWare 5.14 or earlier is used.

Workaround: Upgrade to RW5.14.01 or later